
About
Gives copyright and author information on the program.



Add Ellipse Objects
Puts the program into Add Ellipses mode.



Add Headline Objects
Puts the program into Add Headlines mode.



Add Line Objects
Puts the program into Add Lines mode.



Add Picture Objects
Puts the program into Add Pictures mode.



Add Rectangle Objects
Puts the program into Add Rectangles mode.



Add Rounded Rectangle Objects
Puts the program into Add Rounded Rectangles mode.



Add Text Objects
Puts the program into Add Text mode.



Append New Page
Inserts a new page after the current page.



Arrange Icons
Arranges the icons of any minimized windows at the bottom of the screen.



Banner Font dialog box
Select the font that you want to use for the banner.    Note that it is not necessary to select a font size -- the program 
will determine the font size automatically.



Banner Text dialog box
Enter the text that you want to appear on the banner.



Border dialog box
The Border dialog box is where you decide what kind of border a text object will have.

Color
Click on the color that you want the border to be.

Size
Type in the size (in pixels) of the border.    If you type in 0, no border will appear. 

OK
Press this button to accept the changes made to the border.

Cancel
Press this button to cancel the changes made to the border.

Help
Press this button to get help on this dialog box.



Bottom button bar (text object formatting)
The controls on this bar are used for formatting text objects.    The controls will be active when a text object is the 
current object.    From left to right, the controls are: Change font, change font size, bold, italic, underline, left justify, 
right justify, center justify, justify both, left justified tab stop, right justified tab stop, decimal justified tab stop, and 
center justified tab stop.



Bring To Front
Puts the current object on top of all of the other objects (other than text objects) on the current panel.



Cascade
Arranges the windows in a cascading    (overlapped and slightly offset) format.



Center Horizontally
Centers the current object horizontally on the object's panel.



Center Vertically
Centers the current object vertically on the object's panel.



Close
Closes the current document.    If the current document has not been saved, you will be prompted to save it. 



Connect
Creates a link between the current document and a database.    The Open Database dialog box will come up, and you 
can pick a database to link to the current document.



Contents
Takes you to the help’s Table of Contents.



Copy
Copies the current object to the clipboard so that it can be pasted into a document.



Current Database
Each document can be linked to a database.    This allows you to use the fields of the database in headline objects.    
The current database is the one that is linked to the current document.    Swift Desktop Publisher includes a sample 
database, SAMPLE.DB, that allows you to store name and address information.



Current Document
The current document is the document that is currently showing.    If more than one document is showing, the 
current document is the one with the highlighted title bar.



Current Object
The current object is the object that is highlighted with handles around it.    Since multiple objects can be selected at 
once, sometimes more than one object can be the current object.



Current Page
Each document is made up of an unlimited number of pages.    Only one page will show at a time.    This page is 
called the current page.



Current Panel
The current panel is the panel that the current object is on.



Cut
Deletes the current object, but saves it in the clipboard so that it can be pasted back into a document.



Database Menu
The Database Menu contains items which relate to the current database.

Connect

Disconnect

Edit

First

Prior

Next

Last



Delete
Deletes the current object.



Delete Current Page
Deletes the current page and all objects on it.



Disconnect
Removes the link between the current document and the current database.



Document Type dialog box
The Document Type dialog box allows you to choose a new document's type.    There are 11 different document 
types, each of which is represented by a button.    The button shows how each document type will be folded (if 
applicable).

Document Type Buttons
Press the button corresponding to the document type that you want to create.

Cancel
Press this button if you do not want to create a new document.

Help
Press this button for help with this dialog box.



Down One Level
Exchanges the current object with the object directly below it (unless the current object is a text object).



Edit
Allows you to edit the information in the current database by bringing up the Edit Database dialog box.



Edit Database dialog box
The Edit Database dialog box is where you can change the data in the current database.

Data
This is a grid where you can edit the data in the current database.    Use the mouse or the cursor keys to move 
through the various fields and records, editing the data as you wish.

Navigator
This is the set of buttons in the upper right of the dialog box.    They allow you to move through the records in the 
database.    From left to right, their functions are as follows:

Go to the first record

Go to the prior record

Go to the next record

Go to the last record

Insert a new record

Delete the current record

Post (save) the current record

Cancel any changes made to the current record

Refresh the data (useful when more than one person is using the database simultaneously)

Close
Press this button to close the dialog box.

Help
Press this button to get help on this dialog box.



Edit Description dialog box
Enter new description
Type in a new description for the existing template.

OK
Press this button to accept the new description.

Cancel
Press this button to cancel the new description.

Help 
Press this button to get help on this dialog box.



Edit Menu 
The Edit Menu has choices for manipulating objects with the program's clipboard (the Windows® clipboard is used 
for cutting and pasting text with text objects).

Cut

Copy

Paste

Delete

Select All



Edit Objects
Puts the program into Edit mode.



Edit Purpose dialog box
Enter new purpose name
Type in a new name for the existing purpose.

OK
Press this button to accept the new purpose name.

Cancel
Press this button to cancel the new purpose name.

Help 
Press this button to get help on this dialog box.



Ellipse Object
An ellipse object contains an ellipse and a border that can be resized.



Event Database
Takes you to the Event Database dialog box.    Each event has a particular day, description, and warning period 
associated with it.    If you start up the program within the warning period's number of days before the event, you 
will be told about the upcoming event by its description.



Event Database dialog box
The Event Database dialog box is where you maintain a list of events that the program can warn you about.    Each 
event occurs on a specified date, and you can tell the program to give you a warning message in advance of the 
event.

Calendar
The calendar is where you enter dates for each event.    The date in the upper left corner is the currently selected 
date.    Pressing the left and right red arrow buttons will move the date one month back or one month ahead, 
respectively.    Pressing the Today button will set the date to today's date.    Clicking with the left mouse button on the
calendar will set the date to the day clicked on.    Changing the Month, Day, or Year controls will change the date to 
whatever date is currently showing in the controls.

Help
Press this button to get help on this dialog box.

Status
Shows what the user is currently doing.    The status can be:

Viewing events
The events for the current day are shown.

Add Event
Create a new event on the current day.

Edit Event
Change the description, date, or warning period of the event highlighted in the Events list.

Delete Event
Delete the event highlighted in the Events list.

Move Events
Move all events in the Events list to a new date.

Events
Lists all of the events that occur on the current date.

Close
Closes the dialog box.

Adding a new event, Editing an existing event

Description
Describe the event that you need to create a document for.

Days before event to send message



The program will warn you a certain number of days before the event, when you start up the program.

OK
Press this button to add the event (if adding a new event) or to change the event information (if editing an existing 
event).

Cancel
Press this button to not add the event (if adding a new event) or to not change the event information (if editing an 
existing event).

Moving a group of events to a new date

OK
Press this button to move the events to the new date.

Cancel
Press this button to not move the events to a new date.



Event Messages dialog box
The Event Messages dialog box shows which events you need to make a card for.

Events
The list of events which have generated a warning message.

Delete
Press this button to delete the event highlighted in the Events list.    You would normally do this after creating the 
card that the event calls for, if you won't be using the event next year.

Move to next year
Press this button to move the event highlighted in the Events box ahead by one year.    You would normally do this 
after creating the card that the event calls for, if you want to use the event next year.

Close
Press this button to close the dialog box.

Help
Press this button to get help on this dialog box.



Events Menu
The Events Menu takes you to the part of the program that keeps track of special days so that you won't forget to 
send a document.    Once an event is entered into the event database, every time you start up the program you will be
warned if you need to create and send a document.

Event Database

Messages



Exit
Exits the program.    You will be prompted to save any open, unsaved documents.



File Menu 
The File Menu has choices for creating, opening, saving, and printing documents, and exiting the program.

New

Open

Close

Save

Save As

Save As Template

Print Preview

Print

Print Setup

Send

Exit



First
Shows the first record in the current database.



Font dialog box
The Font dialog box is where you choose a font to use with text objects.

Font
Choose the name of the font that you want to use.    Try to use TrueType™ fonts whenever possible (the ones with 
the TT symbol) because they will make your printed document look more like the one on the screen than other fonts.

Font Style
Changes the basic "look" of a font.

Size
Set the size (in points) that you want the font to be.    A point is 1/72 inch.

Strikeout
Draws a line through the middle of the letters in the font.

Underline
Underlines letters in the font.

Color
Changes the color of the font.    Some colors may not show up well on black and white printers.

Sample
Shows what the resulting font will look like.

OK
Press this button if you are satisfied with your choice of font.

Cancel
Press this button if you want to return to using the previous font.

Help
Press this button to get help on this dialog box.



Go To Page
Prompts you to select a page in the current document to go to, using the Go To Page dialog box.



Go To Page dialog box
Page number to go to:
Enter the page number that you want to go to.

OK
Press this button to go to the entered page.

Cancel
Press this button to close the dialog box without going to a new page.

Help
Press this button to get help on this dialog box.



Grid
The grid is an optional part of each document's display.    The grid is used to make the justification of objects easier 
by providing a backdrop to move the objects around on.    The grid size can be changed to provide different levels of 
resolution, and the grid can be set up so that objects will align on it.



Grid Size
Brings up a submenu that allows the user to set the grid size.    The grid size ranges from 1/32" to 1" (2 mm to 25 
mm if you are using the Metric system).    The current grid size is shown in this menu item, and is checked in the 
submenu.



Headline Object
A headline object is a block of text that can use different fonts, shadowing, and justification to give the effect that 
you want.



Headline Object Properties dialog box
The Headline Object dialog box is where you change the contents and appearance of headline objects.

Text
Type in the text of the headline object.    If you want to end a line before it wordwraps, press the Enter key where 
you want the line to end.    To enter text that can be personalized, surround a descriptive word or two with square 
brackets (example: [First Name]).    To enter a field from the current database, surround a field name with < and >, 
or use the Insert Database Field dialog box.

Insert Database Field
If    the current document is linked to a database, you can press this button to automatically insert a database field 
into the text.

Font
Press this button to change the current font.    It will bring up the Font dialog box.

Shadow
Press this button to change the current shadow.    It will bring up the Shadow dialog box.

Border
Press this button to change the current border.    It will bring up the Border dialog box.

Clear Background
Check this box if you do not want a background color behind the text.

Delete Blank Lines
Check this box if you do not want to show any lines of text that are blank.

Center Horizontally
Check this box if you want the text of the headline object to always center itself horizontally.

Center Vertically
Check this box if you want the text of the headline object to always center itself vertically.

Background Color
Click on the color that you want behind the text.

Justification
Choose which justification you want the text to have.

Direction
Choose which direction you want the text to display in.

Default
Check this box to keep the current attributes as the default.



OK
Press this button to accept the changes made to the headline object.

Cancel
Press this button to cancel the changes made to the headline object.

Help
Press this button to get help on this dialog box.



Help
You can get help at any time by pressing the F1 key.    You can also press the help button (the one with the red 
question mark) while in the main window, or press the help button (the one marked "Help") while in a dialog box.    
Pressing F1 while a menu item is highlighted will give you help on that menu item.    Pressing F1 while not in a 
menu or pressing the button with the red question mark will show you the help's Table of Contents.    Pressing F1 
while in a dialog box or pressing a help button will give you help on the current dialog box.



Help Menu
The Help Menu accesses the program’s on-line help.

Contents

Topic Search

How To Use Help

About



How To Use Help
Shows you help on the Windows® help system.



Image Operations dialog box
The Image Operations dialog box has four parts which can be accessed separately by clicking on the tabs at the top 
of the dialog box.    The four parts are:

Information
Displays information about the current image.

Colors
Allows you to change the color format of the image.    Checking Gray Scale will remove all color information from 
the image.    Checking Dithering will use dithering (combining two existing colors in a pattern to form what looks 
like a new color) in video modes with only 16 or 256 colors.

Effects
Allows you to try different visual effects to change the image.    Checking Red, Green, and/or Blue will apply the 
effect to only the checked color(s).    If you choose the Brightness effect, you will also need to choose a value on the 
slider from -100 to 100.

Transform
Allows you to flip and rotate the image.    For certain flip/rotation choices, you will need to make other choices:

Choose the angle to rotate the image.

Checking Clip Corner will keep the image the same size, clipping any part of the image that is rotated outside of its 
original bounds.

Pressing the Background Color button will open a dialog box allowing you to choose the color that fills in the 
background when the image is rotated.

The buttons at the bottom of the dialog box are:

Preview
Shows what the image will look like with the changes that you have made.

OK
Saves the changes that you have made and exits the dialog box.

Cancel
Cancels the changes that you have made and exits the dialog box.

Help
Press this button for help on this dialog box.



Insert Database Field dialog box
Pick the database field that you want to insert into the Text Object dialog box.

OK
Press this button to pick the selected field.

Cancel
Press this button to exit the dialog box without picking a field.

Help
Press this button to get help on this dialog box.



Insert New Page
Inserts a new page before the current page.



Introduction
The Swift Desktop Publisher program allows you to create an unlimited amount of documents for many purposes.    
You can use the clip art included with the program or your own clip art or fonts to make your own specialized 
documents.    You can create generic document templates that can be personalized for different purposes or people. 
You can create an event database that will prompt you to create documents at the correct time of the year.    You can 
link your document to an existing Paradox® or dBase® database.    And you can do all this quickly and easily.

Useful terms
The following are some terms that are used repeatedly in the help:

Current Document

Object

Text Object

Headline Object

Picture Object

Line Object

Rectangle Object

Rounded Rectangle Object

Ellipse Object

Object Handles

Current Object

Panel

Current Panel

Current Page

Current Database

Mode



Last
Shows the last record in the current database.



Line Object
A line object contains a line of a selected color, style, and size.



Line Object Properties dialog box
This dialog box is where you change the appearance of line objects.

Color
Click on the color that you want the line drawn in.

Style
Click on the style that you want the line drawn with.    Note that styles other than Solid cannot be used if the line 
width is greater than 1

Center Horizontally
Check this box if you want the line object to always center itself horizontally.

Center Vertically
Check this box if you want the line object to always center itself vertically.

Width
Type in the width (in pixels) of the line.    If you type in 0, the line will always have a width of 1, regardless of the 
current zoom level.

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the line object.

Cancel
Press this button to cancel the changes made to the line object.

Help
Press this button to get help on this dialog box.



Link Text Objects
This will allow you to link two text objects so that text from the first object will flow into the second one.    The 
program will be put into Link From mode.    Left click on the first text object to link, or right click to return to Edit 
mode.    After left clicking, left click on the second text object to link, or right click to return to Edit mode.    If you 
click on the same text object twice, this will cancel any link that the object currently has.



Main Window
The main window is where you edit the current document.

You can create a new object by first clicking on one of the mode buttons on the top button bar corresponding to the 
type of object that you want to create.    Then, hold down the left mouse button and drag the mouse to draw a shape 
that shows the outline of the object that you want.    When you are happy with the outline, release the left mouse 
button.    For objects other than text objects, you will then see a dialog box that will let you change the properties of 
the new object.

You can select an object by clicking on it with the left mouse button.    If more than one object is under the mouse 
cursor when you click, the top object will be selected.    You can select an additional object by holding down one of 
the shift keys when you click.    For a text object, you may have to move the mouse cursor to the outside edge of the 
object (where the mouse cursor will change to an arrow) before you can select it.    You can also select a group of 
objects in Edit mode by holding down the left mouse button outside of any objects, dragging the mouse to form a 
rectangle that encloses at least a part of any objects that you want to select, and releasing the left mouse button.

Once an object is selected, you can move it around on the current document by dragging it with the left mouse 
button.    The mouse cursor will change to a hand to show when it is in the correct position to move the object.    For 
text objects, the mouse cursor will only change to a hand when you move it to the outside edge of the object.

You can resize an object by dragging one of the object's handles.    The mouse cursor will change to a two-headed 
arrow (or four-headed arrow for line objects) to show when it is in the correct position to resize the object.    The 
arrowheads will show in which directions the object can be resized.

Headline objects can only be resized to make them wider or thinner, not shorter or taller.    The height of a headline 
object is based on the width of the object and how the text wraps within that width.

Line objects can be forced to be straight while being created or resized by holding down a Shift key or a Ctrl key 
while dragging the mouse.    Holding down a Shift key will force the line to be vertical, and holding down a Ctrl key 
will force the line to be horizontal.

You can access a pop-up menu of commands to perform on an object by right-clicking on the object.



Menu Bar
The menu bar lets you choose commands to help you create your document.    The individual menus and commands 
are discussed in the Menus section of the help.



Menus
File Menu

Edit Menu

View Menu

Page Menu

Object Menu

Personalize

Events Menu

Database Menu

Window Menu

Help Menu



Messages
Shows you the current events which you have been warned about on the Event Messages dialog box.    You can deal 
with each message by deleting it or moving it forward one year (hopefully, you've created the document for the 
event that it warned you about!).



Middle button bar (panel views and database)
Each button on the left side of the bar allows you to see the current document in a different way.    The picture on 
each button corresponds to a panel or panels of the current document that you can view and edit.    When you click 
on a button the program will switch to the button's view of the current document.    To the right of the panel buttons, 
three buttons allow you to view the different pages of the current document    The buttons on the right side control 
access to the current database.    You can see help for each button just like you did for the top button bar.



Minimize All
Minimizes all windows.



Mode
The program can be in one of several modes, which determines what a mouse click on the main window will do.    
You can tell which mode you are in by looking at the mouse cursor (except when the mouse is over a selected text 
object, in which case the mouse cursor will be an I-beam).    The modes (and their mouse cursors) are as follows:

Edit (an arrow)
Add Text (a page of text with a cross)
Add Headlines (a letter "A" with a cross)
Add Pictures (a page of various shapes with a cross)
Add Lines (a line with a cross)
Add Rectangles (a rectangle with a cross)
Add Rounded Rectangles (a rounded rectangle with a cross)
Add Ellipses (an ellipse with a cross)
Move (a grabbing hand)
Link From (a large page of text linking to a small page)
Link To (a small page of text linking to a large page)



New
Creates a new document.    You will be asked if you want to use a template (an existing document) to base your 
document on, or create a completely new document.    If you decide to use a template,    the Open Template dialog 
box will allow you to choose a purpose and description for the document so that you will have something to start 
with.    If you do not want to use a template, the Document Type dialog box will come up so that you can select a 
document type for the new document.    You can personalize the resulting document and change it as you wish.    All 
documents use letter-sized paper, or A4-sized paper if you are using the Metric system.



New Picture dialog box
The New Picture dialog box is where you decide which picture to put in a picture object.

File Name
Type in the name of the picture file that you want to load in the edit box .    Only existing files are valid.    
Underneath is a list box which lists the picture files in the current directory.    Clicking the left mouse button on a file
name will put the file name in the File Name edit box.

List Files of Type
You can ignore this, as there is only one type of file (Pictures), although you can read in files with the extensions 
BMP, JPG, PCX, PNG, TGA, TIF, and WMF.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to look for files on.

Preview
Check this box if you want to see each picture as it is selected in the File Name list box.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to open a picture file.

Help
Press this button for help on this dialog box.



New Purpose dialog box
Enter new purpose name
Type in a name for the new purpose.

OK
Press this button to accept the new purpose.

Cancel
Press this button to cancel the new purpose.

Help 
Press this button to get help on this dialog box.



Next
Shows the next record in the current database.



Next Object
Sets the current object to be the next object.    The next object is defined as the object in the current panel that is on 
top of the current object.    If there is more than one panel on the screen and the current object is at the top, the 
current object will be set to the bottom object in another panel.



Next Page
Shows the next page of the current document.



Object
Every document is made up of objects.    Objects can be text objects, headline objects, picture objects, line objects, 
rectangle objects, rounded rectangle objects, or ellipse objects.    Objects are placed on the document to make it look 
like you want.    Objects can be placed on top of other objects, making other effects possible.



Object Handles
Objects can resized using the "handles" that appear around the edges of an object when it has been selected.    The 
handles look like black squares.    As the mouse cursor is moved over the handles, it changes to reflect the kind of 
resizing that the handle is capable of.



Object Menu 
The Object Menu changes the current object, adds new objects to the current document, or links together two text 
objects.

Bring To Front

Send To Back

Up One Level

Down One Level

Center Horizontally

Center Vertically

Properties

Edit Objects

Add Text Objects

Add Headline Objects

Add Picture Objects

Add Line Objects

Add Rectangle Objects

Add Rounded Rectangle Objects

Add Ellipse Objects

Link Text Objects



Open
Opens an existing document.    You will be prompted to choose the document to open from the Open Document 
dialog box.



Open Database dialog box
The Open Database dialog box is where you decide which database to link to the current document.

File Name
Type in the name of the file that you want to link to in the edit box .    Only existing files are valid.    Underneath is a 
list box which lists the files in the current directory.    Clicking the left mouse button on a file name will put the file 
name in the File Name edit box.

List Files of Type
You can choose either Paradox® or dBase® files.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to look for files on.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to open a file.

Help
Press this button for help on this dialog box.

Network
Press this button (if it exists) to connect to network directories on other computers.



Open Document dialog box
The Open Document dialog box is where you decide which existing document to load into the program.

File Name
Type in the name of the file that you want to load in the edit box .    Only existing files are valid.    Underneath is a 
list box which lists the files in the current directory.    Clicking the left mouse button on a file name will put the file 
name in the File Name edit box.

List Files of Type
You can ignore this, as there is only one type of file.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to look for files on.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to open a file.

Help
Press this button for help on this dialog box.

Network
Press this button (if it exists) to connect to network directories on other computers.



Open Template dialog box
The Open Template dialog box is where you choose which template you will base a new document on.

Purpose
Lists the possible purposes to pick a template from.

Document Description
Lists the descriptions of templates from the currently highlighted purpose. 

Delete Purpose
Deletes all of the templates in the currently highlighted purpose.

Edit Purpose
Changes the name of the currently highlighted purpose using the Edit Purpose dialog box.

Delete Document
Deletes the template with the currently highlighted description.

Edit Description
Changes the description of the currently highlighted template using the Edit Description dialog box.

Template file name
Shows the name of the template's file, in case you want to edit the template directly.    Template files are in the 
TEMPLATE directory.

Document Type
Shows the document type of the currently highlighted template.

Document Text
Shows the text of all of the text objects in the currently highlighted template.

OK
Press this button to accept the currently selected template.

Cancel
Press this button to not create a new document.

Help
Press this button to get help on this dialog box.



Page Menu
The Page Menu allows you to add and delete pages, and to go directly to a particular page.

Insert New Page

Append New Page

Delete Current Page

Go To Page



Panel
Each document (except for banners) has one or more panels, each of which contains objects.    A panel corresponds 
to a single page of the document after it has been folded.    You can view more than one panel at once.    The border 
between different panels is shown with a gray line.    The printable area of a panel (based on the selected printer) is 
the area of the panel inside any light blue lines.    In the case of posters, there is a single panel which contains all four
pages that make up the poster.



Paste
Copies the object in the clipboard into the current document.    The object will appear as a selected object in the 
upper-left corner of the current document that you can move around on the screen.



Personalize 
The Personalize menu item will personalize the current document by asking you to enter specific information in 
places where general information was entered in the document.    When a document is created for a general purpose, 
you may want to use the document in many different cases.    To do this, you create a headline object in a way that 
tells the computer to prompt for specific information.    For example, instead of creating a headline object that says 
"In Business For 20 Years" you would create one that says "In Business For [years] Years".    When you choose the 
Personalize menu item, the program looks for all headline objects that contain words in square brackets, and 
prompts you to enter information corresponding to the words inside the square brackets using the Personalize dialog 
box.    In this example, the computer would prompt you to enter a value for "[years]".    If you typed in "10", the 
headline object's text would change to read "In Business For 10 Years".    Many of the template documents use this 
feature to speed up document creation.



Personalize dialog box
The Personalize dialog box is where you enter the personalized text for a document.

Original text
Shows the text before it has been personalized.

Enter personalized text for [???]
Type in the personalized text to replace [???] with.

OK
Press this button to accept the personalized text.

Cancel
Press this button to stop personalizing the document.

Help
Press this button for help on this dialog box.



Picture Object
A picture object contains a picture that can be resized and modified.    Note that your system should support more 
than 256 colors if you want good results using pictures with 256-color palettes.



Picture Object Properties dialog box
The Picture Object Properties dialog box is where you change the contents and appearance of picture objects.

Center Horizontally
Check this box if you want the picture object to always center itself horizontally.

Center Vertically
Check this box if you want the picture object to always center itself vertically.

New Picture
Press this button if you want to load in a new picture using the New Picture dialog box. 

Modify Picture
Press this button to make changes to the current picture using the Image Operations dialog box.

Restore to original size
Check this box if you want the picture object to be resized to its original size.

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the picture object.

Cancel
Press this button to cancel the changes made to the picture object.

Help
Press this button to get help on this dialog box.



Previous Object
Sets the current object to be the previous object.    The previous object is defined as the object in the current panel 
that is underneath the current object.    If there is more than one panel on the screen and the current object is at the 
bottom, the current object will be set to the top object in another panel.



Previous Page
Shows the previous page of the current document.



Print
Prints the current document using the Print dialog box.    As the document is printing, you may receive instructions 
to flip the printed page over.    This step is necessary to make the document look correct after it is printed and folded.
You will probably need to practice with certain document types to make them look correct.    Note that text objects 
cannot be printed on panels that print upside down.    If a text object is not going to print, a black rectangle will 
appear around the object while you are editing it, and the object will not show up on the print preview.



Print Preview
Shows what the current document will look like when it prints using the Print Preview dialog box.        You can use 
the Previous Page and Next Page buttons to see all of the pages in the current document.    For poster documents, 
text objects are too small to show up, so they will be visible as rectangles with a cross-hatch pattern.



Print Preview dialog box
This dialog box comes up when you want to see what a document will look like when it prints.    You will see both 
the front and back of the document as it will appear when printed.

Close
Press this button to close the dialog box.

Help
Press this button for help on this dialog box.



Print Setup
Changes the printer that you are using or sets up the current printer using the Print Setup dialog box.



Print Setup dialog box
The Print Setup dialog box lets you change the attributes of the currently selected printer.    This dialog box is 
different for every printer.    The standard controls are:

OK
Press this button when you are satisfied with the current printer setup.

Cancel
Press this button to restore the previous printer setup.



Print dialog box
This dialog box comes up just before you print a document.

Printer
Shows which printer is currently selected.

Print Range
Since you will always be printing an entire document, you can ignore this.

Print Quality
If your printer has different print quality modes, you can change the print quality by selecting one of the modes.

Copies
You should always leave this set to 1.

Collate Copies
Since you will always be printing one copy, you can ignore this.

OK
Press this button when you are ready to print.

Cancel
Press this button if you decide not to print.

Setup
Press this button to bring up the Print Setup dialog box.

Help
Press this button for help on this dialog box.



Prior
Shows the prior record in the current database.



Program Window
The Program Window consists of a menu bar, three button bars, a ruler bar, a main window, and a status line with 
two parts.    The menu bar allows you to select menu items (detailed in the following sections).    The button bars let 
you execute commands by pressing a button.    The main window is the background on which other windows will 
appear.    The status line shows the currently selected panel of the current document and help text for each of the 
menu items and buttons.

Menu Bar

Top button bar (commands)

Middle button bar (panel views and database)

Bottom button bar (text object formatting)

Ruler Bar

Main Window

Grid

Status line



Properties
Allows you to change the properties of the current object (unless the current object is a text object).    Different types
of objects use different dialog boxes to change their properties:

Headline objects: Headline Object Properties dialog box
Picture objects: Picture Object Properties dialog box
Line objects: Line Object Properties dialog box
Rectangle objects: Rectangle Object Properties dialog box
Rounded rectangle objects: Rounded Rectangle Object Properties dialog box
Ellipse objects: Ellipse Object Properties dialog box



Rectangle Object
A rectangle object contains a rectangle and a border that can be resized.



Rounded Rectangle Object
A rounded rectangle object contains a rectangle with rounded corners and a border that can be resized.



Ruler Bar
The ruler bar is used to show and change the indents and tab stops in the current text object.    The top half shows the
indents and tab stops, and the bottom half shows a ruler to help set the indents and tab stops.

At the left side of the ruler bar are two triangles.    The bottom triangle can be dragged to set the left indent.    The top
triangle can be dragged to set the indent for the first line of a paragraph.

At the right side of the ruler bar is a large triangle.    It can be dragged to set the right indent.

In the middle of the ruler bar are the active tabs.    There are four different types of tabs: left justified, right justified, 
decimal justified, and center justified.    These tabs can be dragged to change their position.    While being dragged, a 
tab's current position is shown at the far left of    the ruler bar.    If a tab is dragged off of the ruler bar, it will be 
removed.    To place a new tab, press the button on the bottom button bar corresponding to the type of tab that you 
want to create, and then left click on the ruler bar at the position of the new tab.



Save
Saves the current document.    If this is the first time you have saved the current document, you will be prompted to 
give it a name in the Save Document dialog box. 



Save As
Saves the current document under a different name, using the Save Document dialog box.    You would use this to 
save a modified document but still keep the original document.



Save As Template
Saves the current document as a template that can be used to create other documents.    The advantage of saving a 
document as a template as opposed to just saving it is that templates are grouped by purpose and description, so that 
users can tell what the document is without opening it.    When you save a document this way you first save it as a 
normal document file (press the Cancel button in the Save Document dialog box if you want to save the document as
a template only), and then you assign the document to a purpose and give it a description with the Save Document 
As Template dialog box.



Save Document As Template dialog box
The Save Document As Template dialog box is where you add your own documents to the group of built-in 
templates.

Purpose
Lists the existing purposes.

Document Description
Lists the descriptions of the templates in the currently highlighted purpose.

New Purpose
Press this button to add a new purpose to the group of purposes using the New Purpose dialog box.

New Description
Type in a description of the document that you want to add to the templates.

OK
Press this button to add the document to the templates.

Cancel
Press this button to not add the document to the templates.

Help
Press this button to get help on this dialog box.



Save Document dialog box
The Save Document dialog box is where you decide which file name to give to a document.

File Name
Type in a name for the document that you want to save in the edit box .    If you type in the name of an existing file, 
you will be asked if you want to overwrite the file before leaving this dialog box.    Underneath is a list box which 
lists the files in the current directory.    Clicking the left mouse button on a file name will put the file name in the File
Name edit box.

Save File as Type
You can ignore this, as there is only one type of file.

Directories
Lists the current directory, followed by a list box where you can change directories.    Double-click with the left 
mouse button on a directory name to make that directory the current one.

Drives
Bring down this list to choose a different drive to save files on.

OK
Press this button if you are satisfied with the file name that you have selected.

Cancel
Press this button to stop trying to save a file.

Help
Press this button for help on this dialog box.

Network
Press this button (if it exists) to connect to network directories on other computers.



Select All
Selects all of the objects in the current document that are on the screen.



Send
Sends the current document as electronic mail.    This feature is only available in the Windows 95® version of the 
program.



Send To Back
Puts the current object under all of the other objects on the current panel (unless the current object is a text object).



Shadow dialog box
The Shadow dialog box is where you change the shadow properties of a text object.

Position
Set the position of the shadow in relation to the text.    Choose "None" for no shadow.

Color
Choose the color of the shadow.

Offset
Choose the offset (in pixels) of the shadow.    Larger fonts generally need a larger offset.

OK
Press this button to accept any changes that you have made to the shadow.

Cancel
Press this button to cancel any changes that you have made to the shadow.

Help
Press this button to get help on this dialog box.



Rectangle, Rounded Rectangle, and Ellipse Object 
Properties dialog box
These dialog boxes are where you change the contents and appearance of rectangle objects, rounded rectangle 
objects, and ellipse objects.

Color
Click on the color that you want the shape drawn in.

Clear
Check this box if you want a border only and not a filled shape.

Height = Width
Check this box if you want the height of the shape to be equal to its width.

Center Horizontally
Check this box if you want the shape to always center itself horizontally.

Center Vertically
Check this box if you want the shape to always center itself vertically.

Border Color
Click on the color that you want the border drawn in.

Border Size
Type in the size (in pixels) of the border.    If you type in 0, no border will appear. 

Default
Check this box to keep the current attributes as the default.

OK
Press this button to accept the changes made to the rectangle object, rounded rectangle object,    or ellipse object.

Cancel
Press this button to cancel the changes made to the rectangle object, rounded rectangle object, or ellipse object.

Help
Press this button to get help on this dialog box.



Show Grid
If checked, shows the grid on the screen.



Snap To Grid
If checked, will move objects to the nearest grid point whenever they are moved or placed.



Status line
The status line shows two pieces of information:    The name of the current panel (in the left part) and help 
information (in the right part).



Contents
Introduction

Program Window

Help

Menus



Text Object
A text object is a block of text that can be formatted like the text in a word processing document.    The text can use 
any combination of fonts, tabs, and paragraph formatting.    More than one text object can be linked together, 
allowing a single block of text to be spread over multiple columns or pages.    Unlike other objects, text objects are 
always on top of all other non-text objects.



Tile
Arranges the windows in a tiled    (non-overlapped) format.



Top button bar (commands)
The top button bar has buttons that correspond to menu commands.    When you click on a button, it performs the 
same command that the related menu item would have done.

The group of buttons to the left of the help button (the one with the red question mark) correspond to the first eight 
program modes.    Pressing one of these will put the program into the mode that the button represents.    Normally, 
the program switches back to Edit mode after you add a new object, but if you hold down a shift key at the same 
time that you press one of the buttons (other than the Edit mode button), that button will be "locked".    While the 
button is locked, it will not be released until you press one of the other buttons or link two text objects.

Currently disabled buttons are colored all in gray, and cannot be pressed.

If you need to know what a particular button does, move the mouse over it.    After a slight wait, a yellow box will 
pop up over the button that describes it.    This information will also appear on the status line.



Topic Search
Allows you to look up entries in the help alphabetically by name.



Up One Level
Exchanges the current object with the object directly above it (unless the above object is a text object). 



View Menu 
The View Menu changes the view of the current document by zooming in to it or zooming out from it, changing the 
current object, changing the current page, or changing the grid.

Zoom Out

Zoom In

Previous Object

Next Object

Previous Page

Next Page

Show Grid

Snap To Grid

Grid Size



Window Menu 
The Window Menu arranges the program's windows on the screen.

Cascade

Tile

Arrange Icons

Minimize All



Zoom In
Zooms the view in to the current document.    The farthest view is 25%, and zooming in will change the view 
through the range 33%, 50%, 67%, 75%, 100%, 150%, 200%, and finally 250%.



Zoom Out
Zooms the view out from the current document.    The closest view is 250%, and zooming out will change the view 
through the range 200%, 150%, 100%, 75%, 67%, 50%, 33%, and finally 25%.




